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1 INTRODUCTION

1.1 CAUTIONS

CAUTION

The GPS system is operated by the government of the United States, which is solely responsible for its accuracy and
maintenance. Although the GPS 18x is a precision electronic NAVigation AID (NAVAID), any NAVAID can be
misused or misinterpreted, and therefore become unsafe. Use these products at your own risk. To reduce the risk,
carefully review and understand all aspects of these Technical Specifications before using the GPS 18x. When in
actual use, carefully compare indications from the GPS to all available navigation sources including the information
from other NAVAIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before continuing
navigation.

FCC
Compliance

This product has been tested and found to comply with Part 15 of the FCC interference limits for Class B digital
devices FOR HOME OR OFFICE USE. These limits are designed to provide more reasonable protection against
harmful interference in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications if not installed and used in accordance with the instructions. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and the receiver.

e  Connect the equipment into an outlet that is on a different circuit from the GPS unit.
e  Consult the dealer or an experienced radio/TV technician for help.

This product does not contain any user-serviceable parts. Repairs should only be made by an authorized Garmin
service center. Unauthorized repairs or modifications could result in permanent damage to the equipment, and void
your warranty and your authority to operate this device under Part 15 regulations.

190-00879-08 GPS 18x Technical Specifications Rev. B
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1.2 LIMITED WARRANTY

This Garmin product is warranted to be free from defects in materials or workmanship for one year from the date of
purchase. Within this period, Garmin will at its sole option, repair or replace any components that fail in normal use.
Such repairs or replacement will be made at no charge to the customer for parts or labor, provided that the customer
shall be responsible for any transportation cost. This warranty does not cover failures due to abuse, misuse, accident
or unauthorized alteration or repairs.

This product is intended to be used only as a travel aid and must not be used for any purpose requiring precise
measurement of direction, distance, location, or topography. Garmin makes no warranty as to the accuracy or
completeness of map data in this product.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL
OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY ARISING
UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY
VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY TO
USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not allow the exclusion of
incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the purchase price
at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY
BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer, or call Garmin Product Support at one of
the numbers shown below for shipping instructions and an RMA tracking number. The unit should be securely
packed with the tracking number clearly written on the outside of the package. The unit should then be sent, freight
charges prepaid, to any Garmin warranty service station. A copy of the original sales receipt is required as the proof
of purchase for warranty repairs.

Garmin International, Inc.

1200 East 151% Street,

Olathe, Kansas 66062, U.S.A.

Tel. 913/397.8200 or 800/800.1020
Fax 913/397.8282

Garmin (Europe) Ltd.

Liberty House, Hounsdown Business Park,

Southampton, Hampshire, SO40 9RB, U.K.

Tel. +44 (0) 870.8501241 (outside the UK) 0808 2380000 (within the UK)
Fax +44 (0) 870.8501251

Garmin Corporation

No. 68, Jangshu 2nd Road,
Shijr, Taipei County, Taiwan
Tel. 886/2.2642.9199

Fax 886/2.2642.9099
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1.3 OVERVIEW

The GPS 18x series products include an embedded receiver and an antenna. Based on the proven technology found
in other Garmin GPS receivers, the GPS 18x tracks multiple satellites at a time while providing fast time-to-first-fix,
precise navigation updates (five times per second for the GPS 18x-5Hz, and once per second for the GPS 18x USB,
18x PC, and 18x LVC), and low power consumption. This generation of GPS sensors includes the capability of FAA
Wide Area Augmentation System (WAAS) differential GPS.

The GPS 18x design uses the latest technology and high-level circuit integration to achieve superior performance
while minimizing space and power requirements. The hardware capability combined with software intelligence
makes the GPS 18x easy to integrate and use.

The GPS 18x series products are designed to withstand rugged operating conditions and are waterproof to IEC
60529 IPX7, immersion in 1 meter of water for 30 minutes. These complete GPS receivers require minimal
additional components to be supplied by an OEM or system integrator. A minimum system must provide the GPS
with a source of power and a clear view of the GPS satellites. Internal FLASH memory allows the GPS to retain
critical data such as satellite orbital parameters, last-known position, date and time. End user interfaces such as
keyboards and displays are the responsibility of the application designer.

1.4 FEATURES

GPS receiver tracks and uses multiple satellites for fast, accurate positioning and velocity estimates.

Differential DGPS capability using real-time WAAS corrections yielding position errors of less than 3
meters.

Compact, rugged design ideal for applications with minimal space.

Factory configuration meets the needs of most systems that expect NMEA 0183 data from a GPS receiver.
Configuration commands are available to customize the NMEA 0183 output (see section 4.1 Received
NMEA 0183 Sentences)

(GPS 18x LVC and GPS 18x-5Hz only) Highly accurate measurement pulse output for precise timing
measurements: one-pulse-per-second (1 Hz) for the GPS 18x LVC or 5 Hz for GPS 18x-5Hz. Pulse width
is configurable in 20 millisecond increments from 20 ms to 980 ms with 1 us accuracy.

Configurable for binary format data output.

FLASH-based program allows new software revisions through a Web site download.
Non-volatile memory does not require battery backup.

Onboard rechargeable backup battery can maintain the real-time clock for up to 10 days.

Configurable parameters include expected position, current time and date, and preferred position fix type
(3D or automatic).

Waterproof design allows continuous exposure to the prevailing weather conditions at most locations.
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1.5 GPS 18x SERIES

There are several different versions of GPS 18x available. Refer below for a list of the three major divisions of the
GPS 18x Series.

1.5.1 GPS 18x USB

The GPS 18x USB interfaces to a computer with an available USB port. Drivers
are available for use on Windows computers. Macintosh and Linux drivers are
not available from Garmin. After the drivers are loaded, the device appears to the
Windows operating system as a USB-connected device and appears in Device
Manager as a Garmin USB Device.

1.5.2 GPS 18x PC

The GPS 18x PC interfaces to a serial port of a computer via a DB-9
connector and receives power through a 12-volt cigarette lighter adapter.
The unit accepts TIA-232-F (RS-232) level inputs and transmits voltage
levels that swing from zero V (ground) to 5 V TIA-232-F (RS-232)
polarity.

The GPS 18x PC can cause an issue with Windows operating systems if
the DB9 connector is plugged into the computer before the navigation
software is up and running. The Windows operating system may
interpret the serial connector on the GPS 18x as a serial mouse. Please
refer to Appendix D: GPS 18x PC/LVC/18x-5Hz & Window Serial Mouse Issue for complete details.

1.5.3 GPS 18x LVC, GPS 18x LVC-5m, and GPS 18x-5Hz

These products interface to a serial port. The units accept TIA-232-F (RS-232) level inputs and transmit voltage
levels that swing from ground to the positive supply voltage, TIA-232-F (RS-232) polarity. They also have reverse
polarity protection. The cable contains wires for power, ground, receive, transmit, and measurement pulse output.

At the end of the cable, the wires are terminated in a connector that is used
by Garmin for testing purposes. Most customers will remove this
connector and replace it with another connector of their own choosing.
Removing the factory installed connector and/or replacing with another
customer-supplied connector will have no affect on the warranty (see
section 1.2 Limited Warranty). The factory-installed connector will mate
with JST right-angle PCB-mount connector (model BM06B-SRSS-TBT)
or side-entry PCB-mount connector (model SM06B-SRSS-TB). You may
obtain technical information on these PCB-mount mating connectors from
the JST Web site: www.jst.com.

Note: Unless otherwise specified, all references to the GPS 18x LVC also include the GPS 18x LVVC-5m.
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1.6 TECHNICAL SPECIFICATIONS

Specifications are subject to change without notice.

1.6.1 Physical Characteristics

1.6.1.1 Size
61 mm (2.4 inches) in diameter and 19.5 mm (0.77 inches) in height

1.6.1.2 Weight
e GPS 18x USB: 3.7 0z (105 g)
e GPS18xPC: 6.3 0z (180 g)

e GPS 18x LVC-5m (5 meter cable): 5.6 0z (160 g)
e  GPS 18x-5Hz (5 meter cable): 5.8 0z (165 g)

1.6.1.3 Color
Black

1.6.1.4 Case Material
Polycarbonate thermoplastic that is waterproof to IEC 60529 IPX7 level (immersion in 1 meter of water for 30
minutes)

1.6.1.5 Cable Length
o GPS18x USB: 2 meter
e GPS 18x PC: 2 meter
e GPS18x LVC: 5 meter (Garmin Part Number 010-00321-36)
e GPS18x-5Hz: 5 meter

1.6.2 Electrical Characteristics

1.6.2.1 Input Voltage
e GPS18xUSB: 4.4-55Vdc

e GPS18x PC: 8-30 Vdc (Automotive supply from cigarette lighter jack)
e GPS18xLVC: 4.0-55Vdc
e GPS18x-5Hz: 4.0-5.5Vdc
1.6.2.2 Input Current
e GPS18xUSB: 110 mA @ 5.0 Vdc
e GPS18x PC: 65 mA @ 12 Vdc
e GPS18xLVC: 90mA @ 5.0 Vdc
e GPS18x-5Hz: 100 mA @ 5.0 Vdc
1.6.2.3 CMOS Serial Output Levels
e GPS18x PC: 0 Vdc to 5 Vdc (Asynchronous Serial, TIA-232-F (RS-232) Compatible Polarity)

e GPS 18x LVC and GPS 18x-5Hz: 0 Vdc to Vin, between 4 and 5.5 VVdc (Asynchronous Serial, TIA-232-F
(RS-232) Compatible Polarity)

1.6.2.4 GPS Receiver Sensitivity
-185 dBW minimum
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1.6.2.5 Environmental Characteristics
e  Operating Temperature: -30°C to +80°C (-22°F to +176°F)

e  Storage Temperature: -40°C to +90°C (-40°F to +194°F)

1.6.3 GPS Performance

1.6.3.1 Receiver
WAAS Enabled® GPS receiver continuously tracks and uses multiple satellites to compute and update your position.

1.6.3.2 Acquisition Times
e Reacquisition:  Less than 2 seconds

e Hot: Approx. 1 second (all data known)
e Warm: Approx. 38 seconds (initial position, time, and almanac known; ephemeris unknown)
e Cold: Approx. 45 seconds

1.6.3.3 Update Rate
e GPS18x USB, PC, and LVC: 1 record per second

e GPS 18x-5Hz: 5 records per second

1.6.3.4 Accuracy
e  GPS Standard Positioning Service (SPS)

Position: < 15 meters, 95% typical

Velocity: 0.1 knot RMS steady state
e  WAAS

Position: < 3 meters, 95% typical

Velocity: 0.1 knot RMS steady state

o Measurement Pulse Output Time: £1 microsecond at rising edge of the pulse

e Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 2g dynamics

1.6.4 Interfaces

1.6.4.1 GPS 18x Electrical Characteristics
e GPS18x USB: USB 2.0 full-speed protocol compatible, as well as USB 1.1 full-speed protocol.

e GPS18x PC and LVC: TIA-232-F (RS-232) compatible asynchronous receiver. Default setting is 4800
baud.

e GPS18x-5Hz: TIA-232-F (RS-232) compatible asynchronous receiver. Default setting is 19200 baud.

1.6.4.2 Garmin Interface and Garmin USB Protocol

Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for information
about the Garmin Interface and the Garmin USB Protocol. At the time of this printing, this document is located on
the Garmin Web site at: www.garmin.com/support/commProtocol.html.

See Appendix B: Garmin Binary Output Format for additional information concerning access to binary data from
the GPS 18x USB.
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1.6.4.3 GPS 18x PC, GPS 18x LVC, & GPS 18x-5Hz Protocols
e NMEA 0183 Version 2.0 or NMEA 0183 Version 2.30 (Version 2.0 is factory default, programmable by
data field 7 of the PGRMC1 sentence described in section 4.1.4 Additional Sensor Configuration
Information (PGRMC1).

e Available NMEA 0183 output sentences include GPALM, GPGGA, GPGSA, GPGSV, GPRMC, GPVTG,
GPGLL, PGRME, PGRMF, PGRMM, PGRMT, PGRMV, and PGRMB (Garmin proprietary sentences).
See section 4.2 Transmitted NMEA 0183 Sentences for format descriptions.

e Configuration and initialization is accomplished with NMEA 0183 input sentences. Allows initialization of
information such as expected position, date, time, earth datum, and differential mode. See section 4.1
Received NMEA 0183 Sentences for format descriptions.

e Configurable for binary data output.

1.6.4.4 Measurement Pulse Output (GPS 18x LVC & GPS 18x-5Hz only)
e GPS 18x LVC: 1 Hz pulse with programmable width, configurable in 20 ms increments form 20 ms to 980
ms. See section 4.1.3 Sensor Configuration Information (PGRMC) for details about configuring the
Measurement Pulse Output (or PPS) feature.

e GPS 18x-5Hz: 5 Hz pulse synchronized with the time of fix. One of the five pulses will align with the UTC
second boundary. The pulse width is programmable from 20 ms to 180 ms. The PGRMC sentence will
indicate which pulse is at the top-of-the-second. See section 4.1.3 Sensor Configuration Information
(PGRMC) for details about configuring the Measurement Pulse Output (or PPS) feature.

e 1 usaccuracy for all conditions in which the GPS 18x LVC or GPS 18x-5Hz has reported a valid and
accurate position fix for at least the previous 4 seconds.
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2 GPSX 18x LVC & GPS 18x -5Hz WIRING AND PINOUTS

The GPS 18x LVC/18x-5Hz interfaces to a serial port. The unit accepts TIA-232-F (RS-232) level inputs and
transmits voltage levels from ground to the input voltage, TIA-232-F (RS-232) polarity.

The GPS 18x LVC/18x-5Hz wires are terminated with a six-wire connector that is used by Garmin for testing
purposes. You can remove this connector without voiding your warranty (see section 1.2 Limited Warranty).

2.1 GPS 18x LVC & GPS 18x -5Hz PINOUT

GPS 18x Pin Color Signal Name Wire Gauge

#

1 Yellow Measurement Pulse Output 28
2 Red Vin 26
3 Black Ground 28
4 White Transmit Data 28
5 Black Ground 26
6 Green Receive Data 28

Table 1: GPS 18x LVC & GPS 18x-5Hz Wire Pinout

2.2 GPS 18x LVC & GPS 18x -5Hz WIRING DIAGRAMS

GPS 18x LVC and

. GPS 18x-5Hz
Computer Serial Port
Interconnection

O @)

Power Source

(1) Yellow: Meaurement Pulse Output

= Pin 5: Ground (2) Red Vin

{3} Black: GND
+ (3) - \
? 4 Pin 3: Data Out ( hite: TXD >

1€ 4| Pin2: DataIn . (5) Black: GND (Drain Wire) /_
el (6) Green; RCV

. o J DB-9
~  Serial Connector

(Female Pin Contacts)
Figure 1: Computer Serial Port Interconnection
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W
G ®

Power Source

GPS 18x LVVC and

% GPS 18x-5Hz
PDA Serial Port

Serial Connector
(Male Pin Contacts)

Interconnection
_ (1) Yellow. Meaurement Pulse Output
" (2) Red: Vin
Pin 2: Data Out e (3) Black: GND
° (4) White: TXD
: (5) Black: GND (Drain Wire)
Pin 5: Ground = (6) Green ROV
DB-9

Figure 2. PDA Serial Port Interconnection

A

G &)

Power Source

GPS 18x LVC and
Fuse GPS 18x-5Hz

1A
Basic Interconnection

POWER (1) Yellow: Meaurement Pulse Output
. . (2) Red: Vin
GROUND
Host Appllca_tlon ElEcacns
NMEA Device DATA OUT _ (4) White: TXD
DATA IN (5) Black: GND (Drain Wire)
/ > (6) Green: RCV

Figure 3. Basic NMEA Device Interconnection
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3 MECHANICAL CHARACTERISTICS & MOUNTING

The central threaded recess accepts a metric M3 threaded bolt. The recess is approximately 4 mm deep (4.32 +/-
0.08 mm). The following drawings show example geometries for mounting hardware in case you wish to design
your own custom mount. Figure 5 shows mounting geometry for a mount formed from steel sheet metal that is 1.15
mm thick. Figure 7 shows similar mounting geometry for mount formed from aluminum sheet metal that is 1.25 mm
thick. Use caution when tightening the mounting bolt. Tightening the mounting bolt can cause the mount to pull
tight directly against the metal insert, not against the plastic housing, which would tend to pull the insert out of the
plastic. Figure 6 shows the dimensions of our GPS 18x Flush Mount, part number 010-10453-00.

20.00

10.00 -

4x
®33.00

2%

UNITS: MILLIMETERS
Figure 4a. GPS 18x Bottom Case Dimensions, Under Mold

UNITS: MILLIMETERS

Figure 4b. GPS 18x Bottom Case, Outside of Casing
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Figure 5. GPS 18x Suction Cup Mount Center Hole Dimensions

C'SINK 90 °
4X

®5.80
4%

UNITS: MILLIMETERS
Figure 6. GPS 18x Flush Mount Dimensions
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Figure 7. GPS 18x Flush Mount Center Hole Dimensions
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4 GPS 18x PC, GPS 18x LVC, & GPS 18x-5Hz SOFTWARE INTERFACE

The interface protocol design of the GPS 18x PC, LVC, and GPS 18x-5Hz products is based on the National Marine
Electronics Association’s NMEA 0183 ASCII interface specification. This standard is fully defined in NMEA 0183,
Version 2.30. Copies may be obtained from NMEA, www.nmea.org.

In addition to the standard NMEA 0183 sentences, the GPS 18x PC, LVC, and GPS 18x-5Hz may also be
configured to transmit information over their serial interface using NMEA 0183 compliant Garmin proprietary
sentences. These proprietary sentences begin with the characters, “$PGRM?”, instead of the characters “$G” that are
typical of the standard NMEA 0183 sentences. The characters “$P” indicate that the sentence is a proprietary
implementation and the characters and “GRM” indicate that it is Garmin’s proprietary sentence. The letter (or
letters) that follow the characters “$PGRM” uniquely identifies that particular Garmin proprietary sentence.

It is also possible to configure the GPS 18x PC, LVC, and GPS 18x-5Hz to transmit binary data information over
their serial interface. See Appendix B: Garmin Binary Output Format for details.

The GPS 18x USB does not transmit NMEA sentences: It transmits using the Garmin USB interface. The Garmin
USB interface is discussed in the Garmin Device Interface Specification found in the Garmin Device Interface SDK
located on the Garmin Web site at: www.garmin.com/support/commProtocol.html.

You can configure the GPS 18x USB to transmit binary data information over the USB interface. Refer to Appendix
B: Garmin Binary Output Format.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by the GPS
18x PC, LVC, and GPS 18x-5Hz products.

4.1 RECEIVED NMEA 0183 SENTENCES

The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in the
configuration sentence indicate no change in the particular configuration parameter. All sentences received by the
GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return (0D hexadecimal) and
line feed (OA hexadecimal). The checksum *hh is used for parity checking data and is not required, but is
recommended for use in environments containing high electromagnetic noise. It is generally not required in normal
PC environments. When used, the parity bytes (hh) are the ASCII representation of the exclusive-or (XOR) sum of
all the characters between the “$” and “*” characters, non-inclusive. The hex representation must be a capital letter,
such as 3D instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that
point will be acted on by the sensor.

4.1.1 Almanac Information (ALM)
The $GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the unlikely event
of non-volatile memory loss or after storing longer than six months without tracking GPS satellites.

$GPALM,<1>,<2> <3> <4> <5> <6> <7><8>,<9> <10>,<11>,<12>,<13> <14> <15>*hh<CR><LF>

<1> | Total number of ALM sentences to be transmitted by the GPS sensor during almanac download.
This field can be null or any number when sending almanac to the GPS sensor.

<2> | Number of current ALM sentence. This field can be null or any number when sending almanac
to the GPS sensor.

<3> | Satellite PRN number, 01 to 32

<4> | GPS week number

<5> | SV health, bits 17-24 of each almanac page

<6> | Eccentricity

<7> | Almanac reference time

<8> | Inclination angle

<9> | Rate of right ascension

<10> | Root of semi major axis

<11> | Omega, argument of perigee

<12> | Longitude of ascension node

<13> | Mean anomaly

<14> | af0 clock parameter

<15> | afl clock parameter
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4.1.2 Sensor Initialization Information (PGRMI)

The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used for
satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the satellite acquisition
process. If there are no errors in the sentence, it will be echoed upon receipt. If an error is detected, the echoed
PGRMI sentence will contain the current default values. Current PGRMI defaults (with the exception of the
Receiver Command, which is a command rather than a mode) can also be obtained by sending SPGRMIE to the
GPS sensor.

$PGRMI,<1>,<2> <3>,<4> <5> <6> <7>*hh<CR><LF>

<1> | Latitude, ddmm.mmm format for GPS 18x PC/LVC; ddmm.mmmmm format for GPS 18x-
5Hz (leading zeros must be transmitted)

<2> | Latitude hemisphere, N or S

<3> | Longitude, ddmm.mmm format for GPS 18x PC/LVC; ddmm.mmmmm format for GPS
18x-5Hz (leading zeros must be transmitted)

<4> | Longitude hemisphere, E or W

<5> | Current UTC date, ddmmyy format

<6> | Current UTC time, hhmmss format for GPS 18x PC/LVC; hhmmss.s format for GPS 18x-
5Hz

<7> | Receiver Command, A = Cold Start, R = Unit Reset

4.1.3 Sensor Configuration Information (PGRMC)

The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC sentence will contain
the current default values. Current default values can also be obtained by sending $PGRMCE to the GPS sensor.

$PGRMC,<1>,<2> <3> <4> <5> <6>,<7> <8> <9> <10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<1> Fix mode, A = Automatic, 3 = 3D exclusively

<2> Altitude above/below mean sea level, -1500.0 to 18000.0 meters

<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must contain
valid values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A: Earth Datum List
for a list of earth datum and the corresponding earth datum index.

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters resolution)

<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10°° resolution)

<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<9> Differential mode, A = Automatic (output DGPS data when available, non-DGPS otherwise), D =
Differential exclusively (output only differential fixes)

<10> | NMEA 0183 Baud rate, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600,
8 = 38400 (for GPS 18x-5Hz only)

<11> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<12> | Measurement Pulse Output, 1 = Disabled, 2 = Enabled

<13> | Measurement Pulse Output pulse length, (n+1)*20 ms
For 18 LVVC/PC n = 0 through 48 (max. 980 ms)

For GPS 18x-5Hz n = 0 through 8 (max. 180 ms)
Example: n = 4 corresponds to a 100 ms wide pulse

<14> | Dead reckoning valid time 1 to 30 sec. for the GPS 18x PC/LVVC

or 0.2 to 30.0 sec. for the GPS 18x-5Hz

All configuration changes take effect after receipt of a valid value except baud rate and Measurement Pulse Output
mode. Baud rate and Measurement Pulse Output mode changes take effect on the next power cycle or an external
reset event.
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4.1.4 Additional Sensor Configuration Information (PGRMC1)

The $PGRMCL1 sentence provides additional information used to configure the GPS sensor operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMCL1 sentence will contain
the current default values. Current default values can also be obtained by sending $PGRMCLE to the GPS sensor.

$PGRMC1 <1>,<2> <3> <4> <5> <6>,<7>,<8> <9> <10>,<11>,<12>,<13>*hh<CR><LF>

<1> NMEA 0183 output time 1 to 900 (sec). Not applicable to GPS 18x-5Hz, which always outputs data at
5 Hz (200 ms)

<2> Binary Output Data, 1 = Off, 2 = On.

<3> No Effect (This field is not used on this model and is included only for backwards compatibility)

<4> No Effect (DGPS beacon frequency: 0.0, 283.5 to 325.0 kHz in 0.5 kHz steps)

<5> No Effect (DGPS beacon bit rate: 0, 25, 50, 100, or 200 bps)

<6> No Effect (DGPS beacon scanning, 1 = Off, 2 = On)

<7> NMEA 0183 version 2.30 mode indicator, 1 = Off, 2 = On

<8> DGPS WAAS mode, W = WAAS Enabled, N = WAAS Disabled

<9> Power Save Mode, P = Power Save mode, N = Normal

<10> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<11> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<12> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<13> | Measurement Pulse Output Auto Off Mode, 1 = Off, 2 =0On

Configuration changes take effect immediately, with the exception of Binary Output Data, which takes effect on the
next power cycle or a reset event. Send the sentence “$PGRMI,,,,,,,R” to command a reset (refer to section 4.1.2
Sensor Initialization Information (PGRMI)). If the GPS sensor is in the Binary data mode, it is necessary to send the
following eight-byte data stream to temporarily change the data format to NMEA 0183. Then follow by sending a
PGRMC1 sentence that turns off the Binary Output Data format:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

4.1.5 Output Sentence Enable/Disable (PGRMO)
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following sentences
are enabled at the factory for the GPS 18x PC and LVC: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT.

The following sentences are enabled at the factory for the GPS 18x-5Hz: GPGGA, GPGSA, GPRMC, GPVTG, and
PGRMT.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> Target sentence description (for example, PGRMT, GPGSV, etc.)

<2> Target sentence mode, where 0 = Disable specified sentence, 1 = enable specified sentence, 2 =
Disable all output sentences, 3 = Enable all output sentences (except GPALM), 4 = Restore factory
default output sentences

The following notes apply to the PGRMO input sentence:

If the target sentence mode is “2” (Disable all), “3” (Enable all), or ‘4’ (Restore defaults), the target sentence
description is not checked for validity. In this case, an empty field is allowed (for example, $PGRMO,,3), or the
mode field may contain from 1 to 5 characters.

If the target sentence mode is “0” (Disable) or “1” (Enable), the target sentence description field must be an
identifier for one of the sentences that can be output by the GPS sensor.

If either the target sentence mode field or the target sentence description field is not valid, the PGRMO sentence will
have no effect.

$PGRMO,GPALM,1 will cause the GPS sensor to transmit all stored almanac information. All other NMEA 0183
sentence transmission will be suspended temporarily.

$PGRMO,,G will cause the COM port to change to Garmin Data Transfer format for the duration of the power
cycle. The Garmin mode is required for GPS 18x series product software updates.
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4.2 TRANSMITTED NMEA 0183 SENTENCES
The subsequent paragraphs define the sentences that can be transmitted by the GPS 18x PC and LVC.

4.2.1 Sentence Transmission Rate
Sentences are transmitted with respect to the user selected baud rate.

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence descriptions) at a
periodic rate based on the user selected baud rate and user selected output sentences. The GPS sensor will transmit
the selected sentences contiguously. The length of the transmission can be determined by the following equation and
Tables 2 and 3:

total characters to be transmitted
length of transmission =

characters transmitted per second

Sentence Output by Default? Maximum Characters
GPRMC v 74
GPGGA v 82
GPGSA v 66
GPGSV v (PC and LVC only) 70
PGRME 35
GPGLL 44
GPVTG v (18x-5Hz) 42
PGRMV 32
PGRMF 82
PGRMB 40
PGRMM

PGRMT Once per minute 50

Table 2: NMEA 0183 Output Sentence Order and Size

Baud Characters per Second
4800 480
9600 960
19200 1920
38400 3840

Table 3: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values in the
table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. For the GPS 18x
PC and LVC, the factory set defaults result in a once per second transmission at the NMEA 0183 specification
transmission rate of 4800 baud. For the GPS 18x-5Hz, the factory set defaults will result in a five times per second
transmission at 19200 baud.

For the GPS 18x LVC: Regardless of the selected baud rate, the information transmitted by the GPS sensor is
referenced to the one-pulse-per-second output pulse immediately preceding the GPRMC sentence, or whichever
sentence is output first in the burst (see Table 2 above).

For the GPS 18x-5Hz: Regardless of the selected baud rate, the information transmitted by the GPS sensor is
referenced to the preceding five-times-per-second output pulse.

The GPS 18x USB can use Spanner (an application that can provide NMEA output via a virtual COM port) to
receive the same default NMEA sentences as the GPS 18x PC and LVC at a rate of once per second. Spanner is
available for free on the Garmin web site. To download the software, start at www.garmin.com/oem, select the GPS
18x USB, and then select Updates & Downloads.
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4.2.2 Transmitted Time

The GPS sensor outputs Coordinated Universal Time (UTC) date and time of day in the transmitted sentences.
Before the initial position fix, the on-board clock provides the date and time of day. After the initial position fix, the
date and time of day are calculated using GPS satellite information and are synchronized with the measurement
pulse output.

The GPS 18x-5Hz outputs a UTC with a tenths-of-a-second precision: 123456.8, for example.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and correct the
transmitted date and time of day. The transmitted date and time of day for leap second correction follow the
guidelines in ““National Institute of Standards and Technology Special Publication 432 (Revised 1990)” (for sale by
the Superintendent of Documents, U.S. Government Printing Office, Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (Oh Om 0s) of the
day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The GPS sensor
would have transmitted this information for the leap second added December 31, 1998 as follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second will be deleted at the end of some UTC month. The minute
containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not transmit the time of
day Oh Om Os (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69
$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6 A
$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Almanac Data (ALM)

Almanac sentences are not normally transmitted. Send the GPS sensor a $SPGRMO,GPALM,1 command to initiate
almanac transmission. Upon receipt of this command, the GPS sensor will transmit available almanac information
on GPALM sentences. During the transmission of almanac sentences, other NMEA 0183 data output is suspended
temporarily.

$GPALM,<1>,<2> <3> <4> <5> <6>,<7><8>,<9> <10>,<11> <12> <13> <14>,<15>*hh<CR><LF>

<field information> can be found in section 4.1.1 Almanac Information (ALM).
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4.2.4 Global Positioning System Fix Data (GGA)
$GPGGA <1>,<2>,<3> <4> <5> <6>,<7>,<8> <9> M,<10>,M,<11>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format for GPS 18x PC or LVC; hhmmss.s format for GPS
18x-5Hz

<2> | Latitude, ddmm.mmmm format for GPS 18x PC/LVC; ddmm.mmmmm for GPS 18x-5Hz
(leading zeros will be transmitted)

<3> | Latitude hemisphere, N or S

<4> | Longitude, dddmm.mmmm format for GPS 18x PC/LVC; dddmm.mmmmm for GPS 18x-5Hz
(leading zeros will be transmitted)

<5> | Longitude hemisphere, E or W

<6> | GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 =
Differential GPS (WAAS) fix available, 6 = Estimated

<7> | Number of satellites in use, 00 to 12 (leading zeros will be transmitted)

<8> | Horizontal dilution of precision, 0.5 to 99.9

<9> | Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> | Geoidal height, -999.9 to 9999.9 meters

<11> | Null (Differential GPS)

<12> | Null (Differential Reference Station ID)

4.2.5 GPS DOP and Active Satellites (GSA)
$GPGSA <1>,<2> <3> <3> <3> <3> <3> <3> <3> <3> <3> <3> <3> <3> <4> <5> <6>*hh<CR><LF>

<1> | Mode, M = Manual, A = Automatic

<2> | Fixtype, 1 =notavailable,2 =2D,3=3D

<3> | PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be
transmitted)

<4> | Position dilution of precision, 0.5 t0 99.9

<5> | Horizontal dilution of precision, 0.5 to 99.9

<6> | Vertical dilution of precision, 0.5 t0 99.9

4.2.6 GPS Satellites in View (GSV)
$GPGSV,<1>,<2>,<3>,<4> <5> <6>,<7>,...<4> <5> <6> <7>*hh<CR><LF>

<1> | Total number of GSV sentences to be transmitted

<2> | Number of current GSV sentence

<3> | Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)
<4> | Satellite PRN number, 01 to 32 (leading zeros will be transmitted)

<5> | Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)

<6> | Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)
<7> | Signal to noise ratio (C/No) 00 to 99 dB (leading zeros will be transmitted)

Note: Items <4>,<5> <6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites per sentence.
Additional satellites in view information must be sent in subsequent bursts of NMEA 0183 data. These fields will be

null if unused.
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4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC)
$GPRMC,<1>,<2>,<3> <4> <5> <6> <7>,<8> <9> <10>,<11>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format for GPS 18x PC/LVC;

hhmmss.s format for GPS 18x-5Hz

<2> | Status, A = Valid position, V = NAV receiver warning

<3> | Latitude, ddmm.mmmm format for GPS 18x PC/LVC; ddmm.mmmmm format for GPS 18x-
5Hz (leading zeros must be transmitted)

<4> | Latitude hemisphere, N or S

<5> | Longitude, dddmm.mmmm format for GPS 18x PC/LVC; dddmm.mmmmm format for GPS
18x-5Hz (leading zeros must be transmitted)

<6> | Longitude hemisphere, E or W

<7> | Speed over ground, GPS 18x PC and LVC: 000.0 to 999.9 knots, GPS 18x-5Hz: 000.00 to
999.99 knots (leading zeros will be transmitted)

<8> | Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted)

<9> | UTC date of position fix, ddmmyy format

<10> | Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted)

<11> | Magnetic variation direction, E or W (westerly variation adds to true course)

<12> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid

4.2.8 Track Made Good and Ground Speed (VTG)
$GPVTG,<1> T,<2>,M,<3> N,<4> K, ,<5>*hh<CR><LF>

<1> | True course over ground, GPS 18x PC and LVC: 000 to 359 degrees, GPS 18x-5Hz: 000.0 to
359.9 degrees(leading zeros will be transmitted)

<2> | Magnetic course over ground, 000 to 359 degrees, GPS 18x-5Hz: 000.0 to 359.9
degrees(leading zeros will be transmitted)

<3> | Speed over ground, GPS 18x PC and LVC: 000.0 to 999.9 knots, GPS 18x-5Hz: 000.00 to
999.99 knots (leading zeros will be transmitted)

<4> | Speed over ground, GPS 18x PC and LVC: 0000.0 to 1851.8 kilometers per hour, GPS 18x-
5Hz: 0000.00 to 1851.89 (leading zeros will be transmitted)

<5> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid

4.2.9 Geographic Position (GLL)
$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> | Latitude, ddmm.mmmm format for GPS 18x PC/LVC; ddmm.mmmmm format for GPS 18x-
5Hz (leading zeros must be transmitted)

<2> | Latitude hemisphere, N or S

<3> | Longitude, dddmm.mmmm format for GPS 18x PC/LVC; dddmm.mmmmm format for GPS
18x-5Hz (leading zeros must be transmitted)

<4> | Longitude hemisphere, E or W

<5> | UTC time of position fix, hhmmss format for GPS 18x PC/LVC; hhmmss.s format for GPS
18x-5Hz

<6> | Status, A = Valid position, V = NAV receiver warning

<7> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential (WAAS), E = Estimated, N = Data not valid

4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>M,<2>M,<3> M*hh<CR><LF>

<1> | Estimated horizontal position error (HPE), 0.0 to 999.9 meters
<2> | Estimated vertical position error (VPE), 0.0 to 999.9 meters
<3> | Estimated position error (EPE), 0.0 to 999.9 meters
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4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF,<1> <2>,<3> <4> <5> <6>,<7>,<8> <9> <10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<1> | GPS week number (0 to 1023)

<2> | GPS seconds (0 to 604799)

<3> | UTC date of position fix, ddmmyy format

<4> | UTC time of position fix, hhmmss format for GPS 18x PC/LVC; hhmmss.s format for GPS
18x-5Hz

<5> | GPS leap second count

<6> | Latitude, ddmm.mmmm format for GPS 18x PC/LVC; ddmm.mmmmm format for GPS 18x-
5Hz (leading zeros must be transmitted)

<7> | Latitude hemisphere, N or S

<8> | Longitude, dddmm.mmmm format for GPS 18x PC/LVC; dddmm.mmmmm format for GPS
18x-5Hz (leading zeros must be transmitted)

<9> | Longitude hemisphere, E or W

<10> | Mode, M = Manual, A = Automatic

<11> | Fix type, 0 = no fix, 1 = 2D fix, 2 = 3D fix

<12> | Speed over ground, 0 to 1851 kilometers/hour

<13> | Course over ground, 0 to 359 degrees, true

<14> | Position dilution of precision, 0 to 9 (rounded to nearest integer value)

<15> | Time dilution of precision, 0 to 9 (rounded to nearest integer value)

4.2.12 Map Datum (PGRMM)
The Garmin Proprietary sentence $PGRMM gives the name of the map datum currently in use by the GPS sensor.
This information is used by the Garmin MapSource real-time plotting application.

$PGRMM,<1>*hh<CR><LF>

| <1> | Name of map datum currently in use (variable length field, for example, “WGS 84”)

4.2.13 Sensor Status Information (PGRMT)
The Garmin Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor. This
sentence is transmitted once per minute regardless of the selected baud rate.

$PGRMT ,<1>,<2>,<3> <4> <5> <6>,<7> <8><9>*hh<CR><LF>

<1> | Product, model and software version (variable length field, for example, “GPS 18x VER 2.05™)

<2> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<3> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<4> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<5> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<6> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<7> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<8> | No Effect (This field is not used on this model and is included only for backwards compatibility)

<9> | No Effect (This field is not used on this model and is included only for backwards compatibility)

4.2.14 3D Velocity Information (PGRMV)
$PGRMV,<1>,<2>,<3>*hh<CR><LF>

<1> | True east velocity, -514.4 to 514.4 meters/second for GPS 18x PC/LVC; -514.44 to 514.44 for GPS
18x-5Hz

<2> | True north velocity, -514.4 to 514.4 meters/second for GPS 18x PC/LVC; -514.44 to 514.44 for GPS
18x-5Hz

<3> | Up velocity, -999.9 to 999.9 meters/second for GPS 18x PC/LVC; -999.99 to 999.99 for GPS 18x-5Hz
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4.2.15 DGPS Beacon Information (PGRMB)
Note: The GPS 18x products do not support PGRMB at this time.

$PGRMB,<1>,<2>,<3> <4> <5> K,<6>,<7>,<8>*hh<CR><LF>

<1> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<2> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<3> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<4> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<5> | Distance to beacon reference station in kilometers

<6> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<7> | DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix)

<8> | DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS disabled)

4.3 BAUD RATE SELECTION

Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor as
described in the $PGRMC section 4.1.2 Sensor Initialization Information (PGRMI), field <10>.

4.4 MEASUREMENT PULSE OUTPUT (GPS 18x LVC & 18x-5Hz ONLY)

4.4.1 One-Pulse-Per-Second (PPS) Output (GPS 18x LVC Only)

The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise timing
measurements. After the initial position fix has been calculated, the PPS signal is generated and continues until the
unit is powered down. The rising edge of the signal is aligned to the start of each GPS second within 1 ps for all
conditions in which the re ceiver has reported a valid and accurate position for at least the previous 4 seconds.

The NMEA 0183 sentences that follow each rising edge of the PPS signal tell when you were and where you were at
that previous rising edge of the PPS signal, beginning with the GPRMC sentence as the lead sentence in any
particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 18x series products is referenced to the
pulse immediately preceding the NMEA 0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS receiver is computing a valid
position fix. To obtain the most accurate results, the one-pulse-per-second output should be calibrated against a local
time reference to compensate for cable and internal receiver delays and the local time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 980 ms
as described in $PGRMC section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.

4.4.2 Five-Pulse-Per-Second Output (GPS 18x-5Hz Only)

The highly accurate five-pulse-per-second output is provided for applications requiring precise timing
measurements. After the initial position fix has been calculated, the GPS 18x-5Hz generates the pulse signal, which
continues until power down. The rising edge of the signal is aligned to the start of each GPS second within 1 us for
all conditions in which the receiver has reported a valid and accurate position for at least the previous 4 seconds.

The NMEA 0183 sentences that follow each rising edge of the Measurement Pulse Output signal tell when and
where you were at that previous rising edge of the Measurement Pulse Output signal, beginning with the GPRMC
sentence as the lead sentence in any particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 18x-5Hz is referenced to the preceding
five times per-second output pulse.

The accuracy of the five-pulse-per-second output is maintained only while the GPS 18x-5Hz can compute a valid
position fix. To obtain the most accurate results, the five-pulse-per-second output should be calibrated against a
local time reference to compensate for cable and internal receiver delays and the local time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 180 ms
as described in $PGRMC section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.
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APPENDIX A: EARTH DATUM LIST

The following is a list of the Garmin GPS 18x Earth datum indices and the corresponding earth datum name

(including the area of application):

0 ADINDAN-Ethiopia, Mali, Senegal, Sudan

9 AUSTRALIAN GEODETIC 1984-Australia, Tasmania Island

10 ASTRO DOS 71/4-St. Helena Island

11 ASTRONOMIC STATION 1952—Marcus Island

12 ASTRO B4 SOROL ATOLL-Tern Island

13 BELLEVUE (IGN)-Efate and Erromango Islands

14 BERMUDA 1957-Bermuda Islands

15 BOGOTA OBSERVATORY-Colombia

16 CAMPO INCHAUSPE-Argentina

17 CANTON ASTRO 1966—Phoenix Islands

18 CAPE CANAVERAL-Florida, Bahama Islands

19 CAPE-South Africa

20 CARTHAGE-Tunisia

21 CHATHAM 1971-Chatham Island (New Zealand)

22 CHUA ASTRO-Paraguay

23 CORREGO ALEGRE-Brazil

24 DJAKARTA (BATAVIA)-Sumatra Island (Indonesia)

25 DOS 1968-Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967—Easter Island

27 EUROPEAN 1950-Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy,
Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979-Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910-Finland

30 GANDAJIKA BASE-Republic of Maldives

31 GEODETIC DATUM 1949-New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936-England, Isle of Man, Scotland, Shetland Islands,
Wales

33 GUAM 1963-Guam Island

34 GUX 1 ASTRO-Guadalcanal Island

35 HJORSEY 1955-Iceland

36 HONG KONG 1963-Hong Kong

37 INDIAN-Bangladesh, India, Nepal

38 INDIAN-Thailand, Vietnam

39 IRELAND 1965-Ireland

40 ISTS O73 ASTRO 1969-Diego Garcia

41 JOHNSTON ISLAND 1961-Johnston Island

42 KANDAWALA-Sri Lanka

43 KERGUELEN ISLAND-Kerguelen Island
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44 KERTAU 1948-West Malaysia, Singapore

45 L.C. 5 ASTRO-Cayman Brac Island

46 LIBERIA 1964-Liberia

47 LUZON-Mindanao Island

48 LUZON-Phillippines (excluding Mindanao Island)
49 MAHE 1971-Mahe Island

50 MARCO ASTRO-Salvage Islands

51 MASSAWA-Eritrea (Ethiopia)

52 MERCHICH-Morocco

53 MIDWAY ASTRO 1961-Midway Island

54 MINNA-Nigeria

55 NORTH AMERICAN 1927-Alaska

56 NORTH AMERICAN 1927-Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927-Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras,
Nicaragua)

58 NORTH AMERICAN 1927-Canal Zone
59 NORTH AMERICAN 1927-Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927-Caribbean (Barbados, Caicos Islands, Cuba, Dominican Republic, Grand
Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927-Mean Value (CONUS)

62 NORTH AMERICAN 1927-Cuba

63 NORTH AMERICAN 1927-Greenland (Hayes Peninsula)
64 NORTH AMERICAN 1927-Mexico

65 NORTH AMERICAN 1927-San Salvador Island

66 NORTH AMERICAN 1983-Alaska, Canada, Central America, CONUS, Mexico
67 NAPARIMA, BWI-Trinidad and Tobago

68 NAHRWAN-Masirah Island (Oman)

69 NAHRWAN-Saudi Arabia

70 NAHRWAN-United Arab Emirates

71 OBSERVATORIO 1966—Corvo and Flores Islands (Azores)
72 OLD EGYPTIAN-Egypt

73 OLD HAWAIIAN-Mean Value

74 OMAN-Oman

75 PICO DE LAS NIEVES-Canary Islands

76 PITCAIRN ASTRO 1967-Pitcairn Island

77 PUERTO RICO-Puerto Rico, Virgin Islands

78 QATAR NATIONAL-Qatar

79 QORNOQ-South Greenland

80 REUNION-Mascarene Island

81 ROME 1940-Sardinia Island

82 RT 90-Sweden
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83 PROVISIONAL SOUTH AMERICAN 1956-Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela

84 SOUTH AMERICAN 1969-Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay,
Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA-Singapore

86 PROVISIONAL SOUTH CHILEAN 1963-South Chile

87 SANTO (DOS)-Espirito Santo Island

88 SAO BRAZ-Sao Miguel, Santa Maria Islands (Azores)

89 SAPPER HILL 1943-East Falkland Island

90 SCHWARZECK-Namibia

91 SOUTHEAST BASE-Porto Santo and Madeira Islands

92 SOUTHWEST BASE-Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)

93 TIMBALAI 1948-Brunei and East Malaysia (Sarawak and Sabah)

94 TOKYO-Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968-Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916-Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960-Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ-Surinam

102 CH-1903-Switzerland

103 Hu-Tzu-Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan-modified Hu-Tzu-Shan

108 GDA-Geocentric Datum of Australia

109 Dutch
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APPENDIX B: GARMIN BINARY OUTPUT FORMAT

In Binary Output mode, GPS 18x series products will transmit packets once per second. The record contains
primarily post-process information such as position and velocity information. For the GPS 18x PC, GPS 18x LVC,
and GPS 18x-5Hz the record is sent at a default baud rate of 4800 baud, 8 data bits, and no parity.

To turn this record on for the GPS 18x PC, GPS 18x LVC, and GPS 18x-5Hz versions, use the $PGRMC1 NMEA
sentence as described in section 4 GPS 18x PC, GPS 18x LVC, & GPS 18x-5Hz Software Interface. Refer to the
Garmin Device Interface Specification found in the Garmin Device Interface SDK for details on how to form and
parse Garmin packets. At the time of this printing, these specs are available from the technical suppport section of
our Web site: www.garmin.com/support/commProtocol.html.

Note: For the GPS 18x-5Hz, a baud rate of 9600 is not high enough to transmit all of the packets (since they are
output at a 5 Hz rate). You will need to change the baud rate to at least 38400 to be able to transmit all of the
packets. Refer to Appendix C: Changing the Baud Rate in Garmin Mode for information.

For the GPS 18x USB, the records must be enabled by commands to the unit. Refer to the Garmin Device Interface
Specification found in the Garmin Device Interface SDK for details on how to form and parse Garmin packets over
USB. At the time of this printing, these specs are available from the technical suppport section of our Web site:
www.garmin.com/support/commProtocol.html. The ID of each command should be 10 decimal to signify that the
record is a command. The data portion of the packet should be one of the following:

Function Command (base 10)
Position Record On 49
Position Record Off 50

Note that the satellite data information is also enabled when the position record is enabled.

Records sent over RS232 begin with a delimiter byte (10 hex). The second byte identifies the record type (33 hex for
a position record, 34 hex for a receiver measurement and 72 hex for a satellite data record). The third byte indicates
the size of the data. The fourth byte is the first byte of data. The data is then followed by a checksum byte, a
delimiter byte (10 hex), and an end-of-transmission character (03 hex). Additionally, any DLEs (0x10) that appear
between the delimeters are escaped with a second DLE. There is sample code at the end of this section that will strip
off the DLEs and ETXs.

RS232 Packet:

- 0x10 (DLE is first byte)

- Ox##t (Record ID - single byte)

- Ox## (Number of data bytes — single byte)

- data bytes (See descriptions below)

- Ox#t (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10 (DLE)

- 0x03 (ETX is last byte)

USB packets contain a header with a USB transport 1D, a record 1D, and the size of the record data in bytes. All
unused reserved bytes in the header must be zero. Immediately following the header is the record data payload.
Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for details on how to
form and parse Garmin USB packets.

USB Packet:

- Ox## 0x00 0x00 0x00  (USB transport ID, 1 byte unsigned, 4 bytes reserved)
- Ox# Ox## 0x00 0x00  (Record ID, 2 bytes unsigned, 4 bytes reserved)

- Ox# Ox#t Ox#t#t Ox## (Number of data bytes in record, 4 bytes unsigned)

- record data payload

The data bytes of each packet contain the record specified by the record ID. A description of each record follows.
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Satellite Data Record
The satellite data has a record 1D of 0x72 with 84 (0x54) data bytes. The data bytes contain data for 12 satellites as
described below.

typedef struct
uints8 svid; //space vehicle identification (1-32 and 33-64 for WAAS)
uintl6 snr; //signal-to-noise ratio
uint8 elev; //satellite elevation in degrees
uintl6 azmth; //satellite azimuth in degrees
uint8 status; //status bit-field

} cpo_sat_data;

The status bit field represents a set of booleans described below:

Bit Meaning when bit is one (1)
0 The unit has ephemeris data for the specified satellite.
1 The unit has a differential correction for the specified satellite.
2 The unit is using this satellite in the solution.
This pattern is repeated for 12 satellites for a total of 12 X 7 bytes = 84 (0x54) bytes.

The RS-232 Packet for the Satellite Record looks like:

- 0x10 (DLE is first byte)

- 0x72 (Record ID - single byte)

- 0x54 (Number of data bytes — single byte)

- 12 cpo_sat_data records

- Ox# (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10 (DLE)

- 0x03 (ETX is last byte)

The USB Packet for the Satellite Record looks like:

- 0x14 0x00 0x00 0x00  (USB Transport ID, 1 byte unsigned, 4 bytes reserved)
- 0x72 0x00 0x00 0x00  (Record ID, 2 bytes unsigned, 4 bytes reserved)

- 0x54 0x00 0x00 0x00  (Number of data bytes, 4 bytes unsigned)

- 12 cpo_sat_data records
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Position Record

The Position Record has a record identifier of
typedef struct

{

float alt;
float epe;
float eph;
float epv;

int fix;
double gps_tow;
double lat;
double lon;
float lon_vel;
float lat_vel;
float alt vel;
float msl_hght;
int leap_sec;
long grmn_days;

} cpo_pvt_data;

alt Ellipsoid altitude (meters)

epe Estimated position error (meters)

eph Position error, horizontal (meters)

epv Position error, vertical (meters)

fix 0 =no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential;

6 and greater = not defined
gps_tow GPS time of week (sec)

lat Latitude (radians)

lon Longitude (radians)

lon_vel Longitude velocity (meters/second)
lat_vel Latitude velocity (meters/second)
alt_vel Altitude velocity (meters/second)

msl_hght  Height (mean sea level) (meters)
leap_sec UTC leap seconds
grmn_days Garmin days (days since December 31, 1989)
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DLE and ETX bytes:

Sample C code to receive the two records should filter DLE and ETX bytes as described below:

typedef enum

{
DAT,

DLE,
ETX
} rx_state type;

/* Declare and initialize static variables */
static char in_que[ 256 ];
static int in_que_ptr = 0;
static rx_state_type rx_state = DAT;

void add_to_que( char data )

{
#define DLE_BYTE 0x10
#define ETX_BYTE 0x03

if ( rx_state == DAT )
{
if ( data == DLE_BYTE )
{
rx_state = DLE;
}

else

{

in_que[ in_que ptr++ ] = data;

}
else if ( rx_state == DLE )

{
if ( data == ETX_BYTE )
{

rx_state

}

else

{
rx_state = DAT;

in_que[ in_que ptr++ ] = data;
}
}

else if ( rx_state == ETX )

ETX;

{
if ( data == DLE_BYTE )
{
rx_state = DLE;
}
}
if ( in_que_ptr > 255 )
{
in_que_ptr = 0;
}
}
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APPENDIX C: CHANGING THE BAUD RATE IN GARMIN MODE

In certain cases, you may need to change the default baud rate of your Garmin GPS receiver while in Garmin mode.
Follow these steps to temporarily change the baud rate.

Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for details on how to
form and parse Garmin packets. At the time of this printing, these specs are available from the technical suppport
section of our Web site: www.garmin.com/support/commProtocol.html.

1. Turn off all requests by transmitting packet:
id = I0P_RQST_DATA (0x1C)
data = 0 (16-bit unsigned integer )
2. The GPS unit will respond by sending a packet with id = IOP_ACK_BYTE (0x06)
3. After you receive the above packet, transmit packet:
id = IOP_BAUD_RQST_DATA (0x30)
data = baud rate to change to (32-bit unsigned integer; for example, 38400)
4. The GPS unit will respond by sending a packet:
id = |OP_BAUD_ACPT_DATA (0x31)

data = highest acceptable baud rate closest to what was requested
(32-bit unsigned integer; for example, 38361 decimal)

5. Determine the actual baud rate value from the data sent in step 4. This value will be within +/- 5% of the actual
baud rate. (For example, the GPS unit might send a baud rate of 38361, which correlates to a baud rate of
38400).

6. If the baud rate in step 5 is acceptable, transmit packet:
id = IOP_ACK_BYTE (0x06)
data = IOP_BAUD_ACPT_DATA (0x31)

7. Sleep for a small amount of time, about 100 milliseconds, to make sure the packet in (6) was successfully
transmitted to the GPS unit.

8. Close the current connection to the GPS unit and immediately open a new connection with the new baud rate
obtained in step 5.

9. Immediately after establishing a connection, transmit packet:
id = |IOP_CMND_DATA (0x0A)
data = IOP_ACK_PING (0x3A)

10. The GPS will respond by sending a packet:
id=10P_ACK_BYTE (0x06)
data = IOP_CMND_DATA (0x0A)

11. After you receive the above packet, transmit the same packet in step 9 again.
id = IOP_CMND_DATA (0x0A)
data = IOP_ACK_PING (0x3A)

12. The GPS will respond again with the same packet in step 10.
id = IOP_ACK_BYTE (0x06)
data = IOP_CMND_DATA (0x0A)

13. The baud rate has been successfully changed upon receiving the above packet. If the GPS unit does not receive
these two IOP_CMND_DATA packets within two seconds, it will reset its baud rate to 9600.
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APPENDIX D: GPS 18x PC/ LVC/18x-5HZ & WINDOWS SERIAL MOUSE ISSUE

Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 18x PC as the
output of a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial BallPoint
Mouse. This causes the cursor to move erratically about the display, clicking, right clicking, double clicking,
dragging and dropping displayed items as it goes. On Windows 2000 and Windows XP, you may not experience the
problem if you wait until after the computer is booted before connecting the GPS 18x PC to the serial
communications port. This problem is not specific to the GPS 18x PC. Any NMEA 0183 device connected to a
Windows computer’s serial port is likely to cause this problem. Below are several possible solutions to this problem.

Note: If your GPS 18x PC came with Garmin nRoute™ Navigation Software, you will not have this problem; the
unit is programmed to produce data according to the binary format that is described in Appendix B: Garmin Binary
Output Format.

If you wish to use a different navigation software application with your GPS 18x PC, you will need to de-select the
“Binary Output Data” option that is discussed in Solution 3 below.

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. This solution
assumes that you do not need to use a Serial BallPoint mouse with your computer. When erratic mouse movements
occur, follow the steps below.

1. Unplug the DB9 connector.

2. Right-click the My Computer icon on your desktop and select Properties to open Device Manager.
3. Go to the hardware tab of the resulting pop-up window and click on the Device Manager button.

4. Right-click on Serial BallPoint Mouse and choose the option to Disable (NOT uninstall) this device.

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the operating
system is completely booted up and running. Every time you use the GPS 18x PC/LVC, you will need to start the
computer and operating system before making the connection between the GPS 18x PC and the computer. This
solution usually works on Windows 2000 and Windows XP computers.

Solution 3: Change the default output of the GPS 18x PC/LVC so that it does not automatically send NMEA 0183
data to the computer (change the default configuration to enable “Binary Output Data™). Use the Garmin Sensor
Configuration Software, named SNSRCFG.EXE, provided on the Web site to enable “Binary Output Data.” To
download the software, start at www.garmin.com/oem, select the GPS 18x, and then select Updates and
Downloads.

Please note that by enabling “Binary Output Data,” the device will no longer appear as a NMEA 0183 device to your
computer. As a result, mapping applications that expect to hear NMEA 0183 data will not recognize your GPS 18x
P/LVC until you re-enable the NMEA 0183 output, disabling the “Binary Output Data” in the process.

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor
Configuration Software application.

After the Sensor Configuration Software is installed and running on your computer, follow the steps below to
change the default data output of the GPS 18x PC, LVC, or GPS 18x-5Hz.

1. Select the GPS 18x PC / LVC or the GPS 18x-5Hz from the list
of sensors and click OK. The Sensor Configuration Software
opens with the default configuration file for the GPS 18x, as

— Baze Model
shown on the next page.
. . Wwhich Garmi
2. Select Config > Switch to NMEA Mode (or press the F10 key). sensar are vou " GPS 16
i cohnecting ko’
3. Select Comm > Setup to open the Comm Setup Window.  GPS 17«

" GPS 18x-5Hz
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9.

10.

11.

Select the serial port to which the GPS 18x

is connected. Select Auto to have the

program automatically determine the baud

rate, or select Manual to manually select
the baud rate of the GPS 18x. Click OK
when done.

Comm Setup ll

Senial Port:

Baud Rate
f* Auto
" Manual

Cancel |

Click the Connect icon ﬂl or select
Comm > Connect to connect to the GPS
18x.

To view the current programming of the
GPS 18x, select Config > Get

Configuration from GPS (or press the F8
key). The current programming of the GPS

18x is displayed in the window, as shown
on the previous page.

Open the Sensor Configuration Window
by pressing the F6 key or selecting
Config > Sensor Configuration.

Place a check mark in the box next to
“Binary Output Data” to change the GPS
18x to Garmin Mode. The unit will keep
this change in the programming until you
change it again in the software.

Note: Selecting Config > Switch to
Garmin Mode (or pressing the F11 key)
only changes the unit to work in Garmin
Mode until power is cycled through the
unit again. For a more permanent
change, refer to step 8 above.

Click OK.

When you are ready to upload the
changes into the GPS 18x, select Config
> Send Configuration to GPS (or press
the F9 key). The new configuration is
then loaded into the GPS 18x.

You may disconnect and close the
software when finished. The software
configuration can also be saved for
future reference.

Refer to Appendix E: Sensor Configuration
Software for complete information about downloading the Sensor Configuration Software application.

= "SNSRCFG - GARMIN Sensor Configuration Softwa - |EI| X|
File Comm Config Wiew Help -
4 ap|=D=
Configuration file: SNSRCFG
GFZ Fase Hodel: GPE ldx PO/LWC
Zeleated
System Confiquration Sentences:
Baud rats: 4500 bps GPGGA
Power Zave Hode:  0ff (Hormal Made) GPGEA
Fhase Output Data: O£f GRGEY
GPERMEC
NWHER Configuraticn PGRMT
HHER 2.30 Hode: 0gf
WHEA Output Time: 1 =s2<
PPE Comfigquration
FPE mode: 1 Hz
PPZ Lemgth: 100 m=ac
PP Buko OFE: 0gf
GPZ Configquration
Fix mode: Aatomatic
DEFS Hode: MEAE Only
Differential meds: dubomatic
Dead Beckon Time: 20.0 =mac
Latituds: 00% 00000 N
Lemgituds: 000® 00000 E
Bltitude: 200.0 meters
Earth datum index: WEE 54
v
Sensor Configuration x|

— Systemn Configuration

Baud Aate: |192DD "I

[ Paower Save Mode
[ Phase Dutput Data

— MMEA Configuration

[~ MMEA 230 Maode

MMEA Output Time

3

— Pulze-Per-Second [FPS)

¥ Pulse Per Second
" PPS &uto Off Mode

Configuration

PPS Length

w

LCancel |

— Commandz

Frezet Wt
Heset Matwal

Set futalocate

LEE

Test tMode

— GPS Configuration

Fix Mode:

Diff Mode

Alitude:; 300

I.&utomatic ’I Dead Reckon
DGPS Mode: IWN—‘-.S Only 'I
I.&utomatic 'I

Latide: [0 ° [0 "N S
Longitude IU DID " EE W

Walid Time

ISE‘ ZEC

meter

Earth D aturn:

IWGS a4 "I

[ |53?81 a7
[ |298.25?223583

[
B

Il

[
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APPENDIX E: SENSOR CONFIGURATION SOFTWARE

SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features include the
ability to download GPS sensor configuration, maintain different configurations in files, and perform GPS sensor
configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when using the

software to configure your Garmin sensor.

Downloading the Sensor Configuration Software

The Garmin Sensor Configuration Software (SNSRCFG.exe) is available

from the Garmin Web site. To download the software, start at
www.garmin.com/oem, select the GPS 18x, and then select Updates and
Downloads. The Garmin Sensor Configuration Software is included in the

software update download.

Selecting a Model

After opening the program (snsrcfg.exe), the Set Base Model to... Window
appears. Select the radio button next to the type of Garmin sensor you are

configuring.

Connecting to the Sensor

— Basze Model
‘which Garmin  GPS 16

SENSON &re You
conneching to?

GRS 17x

" GPS 18x-5Hz

After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the program.

To configure your sensor, you must first

connect to the xsensor. =loi
File Comm Config Wiew Help -
1. Select Config > Switch to NMEA =
J Q| 2f=|r)r| =l 8
Mode (or press the F10 key).
onfiquration file: SWSECTEx
2. Select Comm > Setup to open the i e | e
Comm Setup WIndOW' Zystem Configquration z:]r-\:::::s
. . Eaud rate: 3E00 bps= [=:4=1k
3. Select the serial port to which the sensor Fower Swww Hode: Off (Howmal Mode)  GFGSA
is connected. Select Auto to have the B i
program automatically determine the MMER Confipuration FoRHT
FHER 2.30 Hode: Off
baud rate, or select Manual to manually ey g
select the baud rate of the GPS 18x. ot emcseaats
Click OK when done. S .
FFZ Length: 100 m=ec
. . gdb ato :
4. Click the Connect icon €3, or select FES Bmto 05 o
Comm > Connect_ GPS.Conf:i.g'urat:i.on .
Fix moda: Zutomatic
H H ode: Waa3 Onl
5. To view the current programming of the D rememtt 1 mode: wvemanis
sensor, select Config > Get EECEE BN s B ECS
Configuration from GPS (or press the Lati tude: 00° 00.000° W
F8 key). The current programming of the eng tudes on g E
sensor is displayed in the window shown
- Earth datum index: WEE 53
to the right.
4
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File Menu

The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work like most

Windows-based programs.

Comm Menu

The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and disconnect

from the sensor.

Setup: Opens the Comm Setup Window. Select the serial port to which x|
the sensor is connected from the drop-down list. Then select Auto (the Sl Pt Baud Rate

program determines the baud rate on its own) or Manual (you then enter [Cov

the baud rate) for the baud rate entry. " Manual

Connect: Select Connect to connect to the sensor to change or view the [oc | cancel |

configuration.

Disconnect: Select Disconnect to disconnect from the sensor.

Config Menu

. " . Si Confi ki b
The Config (Configuration) Menu allows you Sl =
configure the sensor as it is connected. — Gystem Configuration
. A ™| Power Save Mode —
Sensor Configuration (F6): Opens the Sensor Baud Rate: |192cu3 - B ST Canel |
Configuration Window, shown to the right. B =
Many of the fields in this window should be left o
.. . — MMEA Configuration — Commands
alone. Please refer to the beginning of this NMEA Qutput Tine
ificati Fieset Urit |
manual for clarification abo_ut some of_these ™ NMEA 2 30 Mods i - eset Ui
fields. For the most part, this window is used to -
enter a new latitude, longitude, and altitude for Fisset NDn‘~"°'|
the sensor. This is especially helpful when you ~ Pulse-Per-Gecand (PPS) Configuration
are programming the sensor for use in a 7| Eulss Par Sacond PPS Length Eethitoeat]
articular geographic location. - =
P geograp [~ PPS Auta Off Mods [0 = Test Made |
Resetting the Unit (Reset Unit) performs a reset
on the unit, much like cycling the power. — GPS Configuration
Resetting the non-volatile memory (Reset FiMode:  |Automatc =] DeadReckon  EathDatum
NonVol) will clear all of the data from the non- Yalid Time [weses =
volatile memory. DGPS Mode: IWMS Orly vI I—Sd -
Ditf Mode Iﬁutomatic 'I [0 IES?B'I a7
DF. [238.257223563
Latude: [0 ° [0 "N CS o [
Longitude ID ° ID CWE W e ID
Altbude: 300 reter [z ID
NMEA Sentence Selections (F7): Displays the NMEA Sentence Selections x|

Window. If the sentence is enabled, a check mark appears in the box to the left of P

MNMEA Sentence Selectia

the sentence name. Click the box to enable or disable to the sentence. .
I GPGSA [ PGRME
¥ GPGSY [~ PGRMF Aacet
¥ GFRMC ¥ PGRMT _IESE"'
[T GRYTG [~ PGRMY Cancell
[T LCGLL T PGRMM
[T LewTE [ GPGLL
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Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The programming is then
displayed in the Main Interface Window.

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor.

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode when
connected to this software.

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.

Update Software (F12): After you have downloaded a new software version for the sensor, you can update the
sensor with the new software. Select Update Software and then select the file using the Open dialog box. You must
locate both the .rgn file and the updater.exe file.

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also customize how
the program looks by showing and hiding the Toolbar and Status Bar.

Help Menu
The Help Menu displays the software version and copyright information.

For the latest free software updates (excluding map data) throughout the life of your
Garmin products, visit the Garmin Web site at www.garmin.com.

A
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